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Section 1: Introduction 
This manual discusses Highway Addressable Remote Transducer Protocol 
(HART) Pass Through products and applications which may be used in 
conjunction with PACSystems Programmable Controllers (PLCs).  

Section 1:introduces the concepts involved in this topic.  

Section 2:provides a brief tutorial on how to inspect the vendor-supplied 
material.  

Section 3:details how the PLC is to be configured to accommodate and 
support HART Pass Through technology.  

Section 4:discusses the HART Device Type Managers (DTMs) in detail, 
including installation and removal, handling of updates, configuration, 
operation and diagnostics.  

Likewise, Section 5:covers the same topics for HART Multiplexer. 

1.1 PACSystems HART Pass Through Overview 

HART Pass Through is the term given to the bidirectional tunneling of 
Highway Addressable Remote Transducer Protocol (HART) commands and 
responses through a PLC system. The HART communications in question 
are between those HART devices connected to HART-capable analog I/O 
modules and a monitoring station. Both the I/O and the monitoring station 
must be connected to the same PLC. 

Compatible PACSystems PLC CPUs support two independent and distinct 
HART Pass Through technologies:  

• PACSystems Field Device Tool (FDT) HART Device Type Managers 
(DTMs) and  

• the PACSystems HART Multiplexer.  
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Both technologies support HART devices connected to analog IO modules 
with HART support. As illustrated in Figure 1, the analog I/O modules may 
be in any of the following location: 

1. an RX3i CPU rack, 

2. an RX3i PROFINET Scanner rack (i.e. an I/O rack under the control of 
a PNS001 or PNS1011 module), or 

3. an RX3i PROFINET CEP remote drop, which is always controlled by a 
CEP001 module. 

Support for the PROFINET racks requires that the supervising RX3i 
PROFINET IO Controller (PNC001) be in the RX3i CPU rack. Operation with 
Hot Standby CPU Redundancy and PROFINET I/O is supported using a 
redundant IP connection. 

The primary difference between the PACSystems FDT HART DTMs and the 
PACSystems HART Multiplexer is that they are designed to work with 
different types of HART asset management applications.  

• The PACSystems FDT HART DTMs are installed whenever the HART 
devices will be configured and monitored using an FDT Frame 
Application such as Emerson Device Manager Essentials or another 
FDT-compatible asset management application, as shown in Figure 
1.  

• The PACSystems HART Multiplexer is installed whenever the HART 
devices will be configured and monitored using AMS™ from Emerson 
Process Management™, as shown in Figure 2.  

Both technologies require Ethernet communications between the host PC 
and the PLC. Note that the architecture of the PLC system is the same in 
either solution. 

  

 
1 If used with HART modules in place of a PNS001, a PNS101 would not typically be deployed in a 

Sequence of Events configuration. 
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1.2 PACSystems FDT HART DTMs 

The concept of the FDT (Field Device Tool) technology is to provide a 
standardized interface between engineering tools and the components 
which provide the engineering inputs. This standardization provides 
several benefits: 

o Device manufacturers provide a driver, known as a Device Type 
Manager (DTM), for their devices which they manufacture. All 
compliant DTMs are supported in any FDT-capable application. This 
reduces the number of separate applications necessary and allows the 
device vendors to distribute their expertise with respect to their 
devices to all compatible applications, using qualified and tested DTMs. 

o Manufacturers of the communication system components such as 
multiplexers, PLCs, bus couplers, or gateways also provide 
communication and gateway DTMs. This enables the various FDT-
capable applications to communicate through their physical 
topologies to one centralized application. 

o The FDT Frame Application provides a standard point of access to 
equipment supplied by many vendors. It also unifies the system 
topology into one project via parameterization of all components. The 
information is gathered together into one database for archival and 
documentation. 

The PACSystems FDT HART DTMs are the Communication and Gateway 
DTMs. They allow an FDT Frame Application to communicate with the HART 
devices attached to analog channels on PACSystems HART-capable analog 
modules. 

Manufacturers of HART devices produce specific HART device DTMs to 
communicate with those devices. These HART device DTMs must be 
installed in addition to the PACSystems FDT HART DTMs. 

Figure 1: HART Pass Through Showing HART DTMs
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1.3 PACSystems HART Multiplexer 

The PACSystems HART Multiplexer is a Windows® Service that interfaces 
with a software product called AMS supplied by Emerson Process 
Management. This service acts as a single intermediary between AMS and 
those HART devices which present themselves to the HART multiplexer. 
The HART multiplexer manages the communications to and from each 
HART device as well as communicating with the AMS software.   

The Multiplexer is configured with the PACSystems HART Multiplexer 
Configuration Tool application. 

The required AMS components are  

• Device Manager Application,  

• HART Multiplexer Interface, and  

• Number of tags required for the target system.  A tag is required for 
each HART device and for the PACSystems HART Multiplexer itself. 
Tags are also required for spares and for retired devices that are to 
be tracked. 

AMS ships with HART device drivers for communicating with HART devices 
made by several manufacturers. It is also capable of importing new HART 
device type descriptors. 

Figure 2: HART Pass Through Showing HART Multiplexers
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1.4 Specifications 

Hardware 
PACSystems CPU Firmware 8.50 or later 

PACSystems Analog I/O Modules 

Supported HART-capable modules: 
IC695ALG626 -16 Channel Analog Input 
IC695ALG628 – 8 Channel Analog Input (CPU 
Main rack only) 
IC695ALG728 – 8 Channel Analog Output 

PACSystems PROFINET Interface 
Modules 

Supported PROFINET IO Controller modules: 
IC695PNC001 – v2.20 or later 
Supported PROFINET IO Devices: 
IC695PNS001 and IC695PNS101– v2.30 or later 
IC695CEP001 – v2.30 or later 
IC695CPE330 – v8.90 or later (with PROFINET 
enabled) 
IC695CPE400 – all versions 
IC695CPL410 – all versions 
EPSCPE100 – all versions 
EPSCPE115 – all versions 
EPXCPE205 – all versions 
EPXCPE210 – all versions 
EPXCPE215 – all versions 
EPXCPE220 – all versions 
EPXCPE240 – all versions 

 

PACSystems FDT HART DTMs 

FDT Version 1.2.1 

Microsoft 
Windows® OS 
support 

Windows® XP (32-bit), Windows® 7 (32-bit or 64-bit),  
Windows® 8.1 (32-bit or 64-bit), Windows® 10 (32-bit or 64-bit) 

System 
Requirements 

Consult the requirements of the FDT Frame application.  
The FDT Frame application must support FDT Version 1.2 or 1.2.1 
DTMs. 

 

PACSystems HART Multiplexer 
Microsoft Windows® OS 
support 

Windows® XP SP3 (32-bit), Windows® 7 (32-bit or 64-
bit),  
Windows® 8.1 (32-bit or 64-bit), Windows® 10 (32-bit 
or 64-bit) 

System Requirements Consult the AMS requirements. 
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1.5 Glossary 

AMS Asset Management System. Refers to an Emerson 
product in this manual. 

Communication DTM A DTM that represents the component of the PLC system 
that communicates directly with the PC hosting the 
Frame Application. For example, the PACSystems HART 
Communications DTM can communicate from the PC to 
the PLC over Ethernet. 

Device DTM A DTM that represents the device being managed (such 
as a HART device) by an FDT Frame Application. Third 
party manufacturers of HART devices will typically 
provide a HART Device DTM that users install to enable 
the Frame Application to issue HART commands to that 
device. 

DTM Device Type Manager - A DTM is a software driver 
component that provides a protocol interface between 
an asset (such as a HART device) and a Frame Application 
as defined in the FDT Interface Specification. DTMs can 
range in complexity from a simple graphical user 
interface for setting device parameters up to a highly 
sophisticated application that, for example, can perform 
complex calculations for diagnostics and maintenance 
purposes or can implement arbitrarily complex business 
rules for device calibration. Three types of DTMs are the 
Communication DTM, the Gateway DTM, and the Device 
DTM. 

FDT Interface Specification Field Device Tool – FDT is a concept defined in the FDT 
Interface Specification that describes a standardized 
communication and configuration interface between 
device-specific software components provided by 
device suppliers (the DTMs) and the asset 
management tool (the Frame Application) for the 
purposes of commissioning, diagnostics, and 
documentation of fieldbus-based control systems. 

Frame Application An application defined in the FDT Interface Specification 
that manages DTM instances and provides the user 
interface and communication mechanisms necessary for 
a user to configure and monitor assets, such as HART 
devices. Emerson Device Manager Essentials™ is an 
example of a Frame Application. 
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FDT Group  the FDT Group is an open, independent, not-for-profit 
association of international companies dedicated to 
establishing the FDT Technology as an international 
standard with broad acceptance in the automation 
industry. The FDT Group was founded in September 
2005 as an International Not-For-Profit Association 
(AISBL) according to Belgian law. See 
http://www.fdtgroup.org 

Gateway DTM A DTM that represents a component of the control 
system between the HART device and the component of 
the control system that communicates directly with the 
PC hosting the Frame Application. A Gateway DTM 
connects a Communication DTM to a Device DTM or to 
another Gateway DTM or connects a Gateway DTM to a 
Device DTM or to another Gateway DTM. 

HART Highway Addressable Remote Transducer Protocol – A 
digital industrial automation protocol that accomplishes 
the transmission of digital data over a 4-20 mA analog 
signal. 

HART Multiplexer A HART multiplexer can direct HART communications 
from a single source to multiple destinations and vice-
versa. 

HWC PAC Machine Edition Hardware Configuration, which is 
downloaded from PAC MACHINE EDITION to the PLC 
CPU. 

PLC Programmable Logic Controller 

PME PAC Machine Edition: A software tool used to configure 
PACSystems PLCs. 

  

http://www.fdtgroup.org/
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1.6 Revisions in this Manual 

Rev Date Description 

D Nov 2022 

Updated to reflect RSTi-EP backplane controllers’ compatibility with 
PACSystems PROFINET interface modules.  

Minor updates to document RSTi-EP backplane controller’s 
incompatibility with redundant IP addresses.  

C Dec 2020 

Updated multiplexer name displayed in Section 5.1.1 

Minor updates to document to comply with Emerson’s style 
guidelines.  

B Sep 2019 

Following Emerson’s acquisition of this product, changes have been 
made to apply appropriate branding and registration of the product 
with required certification agencies. No changes to material, process, 
form, fit or functionality. 

A July 2018 
Add support for CPUs with embedded PROFINET Controller. 
(IC695CPE330, IC695CPE400, IC695CPL410, EPSCPE100, and 
EPSCPE115) 

- May 2015 Initial version. 
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1.7 PACSystems Documentation 

PACSystems Manuals 

PACSystems RX7i, RX3i and RSTi-EP CPU Reference Manual GFK-2222 

PACSystems RX7i, RX3i and RSTi-EP CPU Programmer’s  
Reference Manual      GFK-2950 

PACSystems RX7i, RX3i and RSTi-EP TCP/IP Ethernet Communications  
User Manual       GFK-2224 

PACSystems TCP/IP Ethernet Communications Station Manager  
User Manual       GFK-2225 

PAC Machine Edition Logic Developer Getting Started  GFK-1918 

PAC Process Systems Getting Started Guide   GFK-2487 

PACSystems RXi, RX3i, RX7i and RSTi-EP Controller Secure  
Deployment Guide      GFK-2830 

PACSystems RX3i & RSTi-EP PROFINET I/O Controller Manual GFK-2571 

RX3i Manuals 

PACSystems RX3i System Manual    GFK-2314 

PACSystems RX3i PROFINET Scanner Manual  GFK-2737 

PACSystems RX3i CEP PROFINET Scanner User Manual GFK-2883 

PACSystems RX3i 1GHz 64MB CPU w/Ethernet IC695CPE330  
QuickStart Guide      GFK-2941 

PACSystems RX3i 1.2GHz 64MB CPU w/Field Agent IC695CPE400  
Quick Start Guide      GFK-3002 

PACSystems RX3i 1.2GHz 64MB CPU w/Linux IC695CPL410  
Quick Start Guide      GFK-3053 

In addition to these manuals, datasheets and product update documents 
describe individual modules and product revisions. The most recent 
PACSystems documentation is available on the Emerson support website    
https://www.emerson.com/Industrial-Automation-Controls/support.

https://www.emerson.com/Industrial-Automation-Controls/support
https://www.emerson.com/Industrial-Automation-Controls/support
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Section 2: Equipment Inspection 
Upon receiving your equipment, carefully inspect all shipping containers 
for damage. If any part of the system is damaged, notify the carrier 
immediately. The damaged shipping container should be saved as 
evidence for inspection by the carrier.  

As the consignee, it is your responsibility to register a claim with the carrier 
for damage incurred during shipment. Emerson will fully cooperate with 
you, however, should such action be necessary.  

After unpacking the equipment, record all serial numbers. Serial numbers 
are required if you should need to contact Customer Care during the 
warranty period. All shipping containers and all packing material should 
be saved should it be necessary to transport or ship any part of the system. 

Verify that all components of the system have been received and that they 
agree with your order. If the system received does not agree with your 
order, contact Customer Care. 

If you need technical help, contact Technical Support. For phone numbers 
and email addresses, see the Contact Information page at the beginning 
of this manual.
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Section 3: PLC Configuration 
PAC Machine Edition (PME) is the software package used to configure all 
aspects of the PACSystems PLC system, including the HART Pass Through 
features. However, PAC MACHINE EDITION does not configure AMS or 3rd 
Party Analog I/O devices. 

The configuration of a HART-enabled system has three distinct parts: 

• Within the Hardware Configuration of the PLC, HART Pass Through 
communications must be enabled on each of the host analog IO 
modules  

• The various parametric settings for each HART device must match the 
corresponding field operation settings 

• The asset management tool must be configured with suitable 
communication settings. 

This chapter explains the procedure, within the Hardware Configuration of 
the PLC, to enable HART communications on the host analog IO modules. 

3.1 Overview 

The HART modems within the compatible analog modules are disabled by 
default, as each analog module supports many modes of operation. For 
each analog channel that will be using HART in the application, the 
minimum required configuration is 

a. To set the channel to 4-20mA operation and  

b. To enable HART communications. 

3.2 Enabling HART on the Main PLC Rack 

To add a HART-capable module to the main PLC rack, double click on the 
appropriate slot within the PAC MACHINE EDITION Navigator pane and 
select the desired module from the Analog Input or Analog Output tab of 
the Catalog. For instance, IC695ALG626 is being selected in Figure 3. 
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Figure 3: Selection of HART-Capable Analog I/O Module for Slot in PLC Rack

 

Within the configuration of the analog module selected in Figure 3, use the 
drop-down menu to set the HART Pass-thru Service Options to Pass-Thru 
Only. This selection prevents the module from scanning HART variables 
into the CPU Reference Memory. 

Figure 4: Setting HART Pass-Thru Only for an Analog I/O Module
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Within the configuration of the analog module selected in Figure 3, 
configure each channel that will be used for HART communications with 
the settings shown in Figure 5. The following are the minimum settings 
required: 

- Range Type: Voltage/Current 

- Range: 4mA to 20mA 

- HART Communications: Enabled 

Figure 5: Minimum Settings Required for each HART Channel

 

Other settings, such as Alarm settings, may also be configured as shown 
in Figure 5, but are not required for HART operations. 
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3.3 Enabling HART on a Remote Rack 

For HART communications to be exchanged with a HART-capable analog 
module located with a remote PROFINET drop, the interfacing PROFINET 
device (PNS001, PNS101, or CEP001) must be configured and have an 
active PROFINET connection. It must also be connected to a CPU with 
embedded PROFINET (ex: CPE400) or a rack-mounted PROFINET Controller 
(ex: PNC001) located in the main PLC rack. For general information 
regarding remote rack setup and configuration refer to: 

- PACSystems RX3i PROFINET I/O Controller Manual, GFK-2571, 

- PACSystems RX3i PROFINET Scanner Manual, GFK-2737, and  

- PACSystems RX3i CEP PROFINET Scanner Manual, GFK-2883. 

Enabling HART communications on a HART-capable analog module in a 
remote rack is very similar to the process described above for the main PLC 
rack. In configuring a HART-capable analog module, each analog channel 
that will be connected to a HART device must have: 

• its Range Type set to Voltage/Current,  

• its Range set to 4mA to 20mA, and  

• its HART Communications set to Enabled within the 4mA to 20mA 
range configuration. 
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Figure 6: Configuring Analog Channels for HART within a PROFINET Remote 
Drop 

 

If the HART Communications configuration parameter is not displayed, 
verify that the PROFINET device GSDML version supports HART Pass 
Through communications.
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Section 4: FDT HART DTMs 

4.1 Installation 

The PACSystems Field Device Tool (FDT) HART Device Type Managers 
(DTMs) are installed using a Windows® Installation package. Install the 
DTMs on the PC which hosts the FDT Frame Application. Once installed, the 
following DTMs are available to the FDT Frame Application: 

• PACSystems HART Communications: This is the Communications 
DTM which manages the connection between the PC to the PLC. 
There is one instance of this DTM per HART Pass Through system. 

• PACSystems HART-capable Analog Module: This is a Gateway DTM 
which represents a single analog module in a PACSystems rack. It 
allows that analog module to support one HART Device per analog 
channel. 

• PACSystems CPU with PROFINET IO Controller: This is a Gateway DTM 
which represents a CPU with an embedded PROFINET IO controller.  
It may be standalone such as an IC695CPE400 or in a PACSystems 
rack such as an IC695CPE330. 

• PACSystems PROFINET IO Controller Module: This is a Gateway DTM 
which represents a PROFINET IO Controller such as an IC695PNC001 
in a PACSystems rack. 

• PACSystems RX3i PROFINET CEP and IO Scanner: These are Gateway 
DTMs which represent the RX3i PNS Scanner module or RX3i CEP 
module. 

In order to operate the PACSystems FDT HART DTMs, a valid license must 
be installed on the PC. Licenses can be ordered as part number HD10 – 
HART Communications DTMs for PACSystems RX3i. 

4.1.1 Install Process 

Steps to install the PACSystems FDT HART DTMs are: 

1. Verify the requirements as listed in the Specifications tables in 
Section 1.4 

2. Log into the PC as a user with administrator privileges 
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3. Exit all running programs 

4. Start Setup.exe from the installation medium 

5. Follow the instructions in the dialogs presented 

6. Install a license for the PACSystems FDT HART DTMs using the 
PACSystems Common License Manager, which is installed in Start -> 
All Programs -> PACSystems Common -> License Manager. The 
license installation procedure is detailed in the License 
Documentation file installed with the License Manager. Licenses can 
be ordered as part number HD10 – HART Communications DTMs for 
PACSystems RX3i. 

7. Start the FDT Frame Application 

a. Verify that PACSystems HART Communications is displayed as an 
available Communication DTM.  

b. Many FDT Frame Applications will detect a change to the 
installed DTMs and automatically refresh the catalog on start-up. 
If not, you may need to command a refresh of the catalog from 
within the FDT application to access the PACSystems FDT HART 
DTMs.  

c. Verify that each of the following are displayed as available 
Gateway DTMs: 

i. PACSystems HART-capable Analog Module 

ii. PACSystems PROFINET IO Controller Module 

iii. PACSystems RX3i PROFINET CEP Scanner 

iv. PACSystems RX3i PROFINET IO Scanner. 

4.1.2 Uninstall Process 

The FDT DTMs are listed as one Program in the Programs and Features 
Control Panel applet and are uninstalled as a single Program. Exit all FDT 
Frame Applications and then use the Uninstall option on PACSystems HART 
Device Type Managers in the Programs and Features applet. 

4.1.3 Updates 

The Windows® Installation package is configured to automatically 
uninstall any previous version of the PACSystems FDT HART DTMs. To 
update to a newer version, simply run the Windows® Installation package 
for the newer version and open the FDT Frame Application. The Frame 



Hart Pass Through User Manual Section 5 
GFK-2929D                Nov 2022 
 

FDT HART DTMs  18 

Application will detect the changes and refresh its catalog. The project will 
use the updated DTMs without any additional actions. 

The Windows® Installation package will fail and report if a newer version 
is already installed. If it is necessary to install an older version of the DTMs, 
the older version must be manually uninstalled from the Programs and 
Features Control Panel before running the installer for the older version. 

4.2 Configuration 

This section explains the procedure required to configure the HART Device 
Type Managers (DTMs) within an FDT Frame Application for HART Pass 
Through operations to a PACSystems PLC. 

4.2.1 Configuration Overview 

The FDT Frame Application supports configuration of individual projects 
within its confines. All configuration activities are performed within the FDT 
Frame Application.  Specific procedures vary and are unique to each FDT 
Frame Application. 

When complete, the FDT Frame Application project contains  

a. all the information as to which components form the HART Pass 
Through system and  

b. the topology representing how the components are interconnected.  

The configured information remains completely within the FDT Frame 
Application host and is used in the subsequent generation of HART 
protocol requests to devices.  

Configuration is entered by building the project within the FDT Frame 
Application and configuring topology settings via Configuration and 
Parameter dialogs.  

Each HART-capable device may have associated parameters that govern its 
operation. The parametric data is configured within the project at the FDT 
Frame Application and is subsequently communicated to the 
corresponding devices, where it is stored.  

Parameters differ from Configuration in that they are stored to the device 
from the FDT Frame Application, whereas Configuration elements are 
retained at the FDT Frame Application level.  
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Typically, a HART-capable device requires one or more DTMs to manage 
communications between the Frame Application and the device. 

4.2.2 Basic FDT Frame Application Configuration Steps 

1. Verify that the PACSystems HART Communications DTM is available 
in catalog of the FDT Frame Application. If not, review the Installation 
process in Section 4.1. 

2. Add an instance of the PACSystems HART Communications DTM to 
the project. This is typically available from the Device menu as Add or 
Add Device. 

3. Configure the DTM by selecting the instance from the project. 
Initially, it displays with the default name of tag_not_available. Select 
Configuration or Parameter from the Device menu. This opens the 
dialog in Figure 7: 

Figure 7: Configuring HART Communications between PC and PLC

 

4. Configure the IP Address of the connection to the PACSystems CPU. 
This can be the IP Address of a CPU-embedded Ethernet interface 
(IC695CPE330, for instance), the IP Address of a rack-mounted 
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Ethernet Interface Module (IC695ETM001), or a redundant IP Address 
in a redundancy system. 

5. Configure the Timeout value for the connection. This is a gross non-
activity timeout for operations between the host PC and the CPU. The 
default is 16 seconds, typically it can be reduced to 8 seconds for 
higher performance CPUs with a separate PROFINET controller. 

6. Communication with HART devices through the PLC requires 
Privilege Level 2 access. Enter the password if a Level 2 Privilege Level 
password has been configured. 

7. Apply the changes with OK or Apply. If the instance is still named 
tag_not_available, it will be renamed to the assigned IP Address at 
this step. The name is generally editable within the FDT Frame 
Application from the project window. If the name is configured to 
something other than tag_not_available or the current IP Address, 
the name will remain unchanged when applying the Configuration 
dialog settings. If the name is the current IP Address and the IP 
Address is modified, it will be renamed to the new IP Address setting. 

At this point in the process, two methods are available for continuing 
forward:  

• Scanning the connected hardware or  

• Manually configuring the topology. 

4.2.3 Scanning Hardware 

In order to scan the existing PLC hardware, a valid PACSystems FDT HART 
DTMs license must be installed on the PC and each PLC hardware element 
must be physically connected, powered up, and capable of 
communicating. In the FDT Frame Application, select the project, then 
select the PACSystems HART Communications DTM instance, then select 
the Create Network or Topology Scan menu option. Depending on the FDT 
Frame Application, this menu item may appear as a sub-menu option 
under a Scan or similarly-named menu option. 
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Figure 8: Typical Menus for Initiating HART Topology Scan

 

This feature first scans all the slots in the CPU rack of the PLC system 
looking for modules that support HART or PROFINET and adds each 
detected element to the project. The result of the scan is based solely on 
the modules physically present in the CPU rack backplane at the time of 
the scan: 

• If a HART-capable analog module or PROFINET IO Controller is 
missing or is not communicating with the PLC CPU at the time of the 
scan, even if present in the downloaded PAC MACHINE EDITION 
Hardware Configuration (HWC), the module will not be included in 
the scan results. 

• If a HART-capable analog module or PROFINET IO Controller is 
configured, but the module present does not support HART, the 
module will not be included in the scan results. 

• If a HART-capable analog module or PROFINET IO Controller is 
present, but is misconfigured, the module will nonetheless be 
included in the scan results. 

This feature then tries to scan each of the added PACSystems HART-
capable Analog Module DTMs for HART devices. In order for a given analog 
channel of a module to be scanned, the module and channel must be 
configured as described in PLC Configuration, Section 3:. 

When scanning a PROFINET IO Controller, the PROFINET network is 
searched for all PROFINET IO Devices. A PROFINET IO Device must be 
present at the time of the scan, and it should have its PROFINET device 
name and network parameters (usually, IP Address and network subnet 
mask) assigned at the time of the scan in order to best match its data with 
a DTM in the catalog. For Emerson products, only the RX3i PROFINET 
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Scanner and RX3i CEP devices are reported. No other Emerson devices 
have an associated DTM and thus are not reported in the scan results. 

If the configuration has multiple non-redundant PNCs on the same 
physical network, the same devices will be discovered via both PNCs. This 
is because the scan is a network scan and is not filtered based on the 
network settings of the PNC or the network settings of the device 
discovered. The scan results may need to be manually edited in these cases 
to remove the duplicate devices and leave them under the PNC that 
controls them during normal PROFINET operation. 

The scan of HART devices attached to HART-capable analog modules in a 
remote PROFINET drop and modules found in the PLC main rack is 
identical. 

Scanning may be initiated at any level within the project topology. For 
example, scanning can be started at the PACSystems HART-capable Analog 
Module DTM instance level to scan a single HART-capable analog module 
for its attached HART devices. 

Whenever the device catalog cannot present an exact match in for a given 
discovered HART or PROFINET IO device, a dialog will ensue. The dialog will 
present the device information discovered and any partial matches found 
in the catalog. To close out the dialog, either select an appropriate DTM for 
the discovered device and add it to the project or ignore this device and 
add nothing. If the Device DTM does not provide the minimum set of 
information to support a match, the DTM may not be selectable as a 
possible match to the scan result. In this case, the Device DTM may still be 
tried by manually adding the device to the project once the scan has 
completed. 

Incremental Scanning of Hardware in Large Systems 

The Create Network or Topology Scan feature of FDT Frame Applications 
builds the topology of the connected system by sequentially scanning each 
channel of the selected DTM instance for its children, followed by 
sequentially scanning every channel of each child DTM instance for their 
children, and so forth. 

The time required to complete a topology scan depends on several factors, 
including the size of the system, the FDT Frame Application, and the HART 
devices themselves. For example, scanning of an IC695ALG626 module 
with one HART device connected to each channel (16 total HART devices) 
may take ~40 seconds to complete. 
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For a small system, a full topology scan may complete quickly. However, in 
a larger system, a full topology scan as one operation may take longer than 
desired. Some FDT Frame Applications include a Life list feature or single-
level scan to allow the user to break a full topology scan into smaller pieces. 
The Life list feature scans the channels of the selected DTM instance and 
add those items to the FDT Frame Application project without continuing 
to scan further in the topology. 

Life list scans can break a large scan into smaller pieces.  Each incremental 
scan can then have its results saved. Other FDT Frame Application features 
can subsequently be employed to drill down and fill out the undiscovered 
device information. In large systems where a full topology scan may be too 
time consuming, use the Life list feature to build the topology out to a point 
where using individual Create Network or Topology Scan operations on the 
lower level children will complete in the desired time. This technique may 
also be applied where a segment of the HART application is deferred to a 
later phase. 

Scanning Hardware in Older FDT Frame Applications 

Older FDT Frame Applications developed to the FDT Specification 1.2 for 
Scanning may not support scanning for HART-capable analog or PROFINET 
IO Controller modules at the PACSystems HART Communications DTM or 
PACSystems RXi PROFINET IO Scanner/PACSystems RX3i PROFINET CEP 
level. However, these FDT Frame Applications do support scanning for 
HART devices at the PACSystems HART-capable Analog Module Gateway 
DTM level. 

In these older FDT Frame Applications, for each slot containing a HART-
capable analog module,  

a. Manually add an instance of the PACSystems HART-capable Analog 
Module Gateway DTM under the PACSystems HART Communications 
DTM (refer to Section 4.2.4) or 

b. Manually add an instance PACSystems RX3i PROFINET IO Scanner / 
PACSystems RX3i PROFINET CEP DTM and then, for each slot 
containing a PROFINET IO Controller, manually add one instance of 
the PACSystems PROFINET IO Controller Module Gateway DTM. 

Once the necessary PACSystems HART-capable Analog Module Gateway 
DTM instances have been added to the project, scanning is performed by 
selecting Create Network from the Scan menu option at each individual 
PACSystems HART-capable Analog Module Gateway DTM instance. 
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These older FDT Frame Applications may also not support scanning for 
PROFINET IO Devices at the PACSystems PROFINET IO Controller DTM. In 
that case, the PROFINET IO Devices must be configured manually and the 
scan re-started at each PROFINET IO Device. 

4.2.4 Manually Configuring Topology 

PROFINET Topology 

1. Verify the PACSystems PROFINET IO Controller Module Gateway DTM 
is available in the catalog of the FDT Frame Application. If not, review 
the Installation process in Section 4.1. 

2. Add an instance of the PACSystems CPU with PROFINET IO Controller 
or PACSystems PROFINET IO Controller Module DTM under the 
PACSystems HART Communications DTM. This is typically available 
from the Device menu as Add or Add Device when the PACSystems 
HART Communications DTM is selected in the project. This will open 
a dialog like the one shown in Figure 9: 
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Figure 9: Manually Assigning PNC to its Resident Backplane Slot

 

Select the slot in the PACSystems backplane that contains (or will contain) 
the PROFINET IO Controller module to be configured. When using a 
standalone CPU, always select Slot 0.  
Repeat this step for each PROFINET IO Controller module which has (or will 
have) downstream HART devices attached. 

3. Add an instance of the PACSystems RX3i PROFINET IO Scanner or 
PACSystems RX3i PROFINET CEP DTM under the PACSystems 
PROFINET IO Controller Module DTM for each remote I/O drop that 
contains (or will contain) HART devices. Assign the DTM name to 
match the PROFINET IO Device name. 

PACSystems Rack Topology 

1. Verify the PACSystems HART-capable Analog Module Gateway DTM is 
available in the catalog of the FDT Frame Application. If not, review 
the Installation process in Section 4.1. 
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2. Add an instance of the PACSystems HART-capable Analog Module 
DTM under the PACSystems HART Communications DTM. This is 
typically available from the Device menu as Add or Add Device when 
the PACSystems HART Communications DTM is selected in the 
project. This opens a dialog like that shown in Figure 10: 

Figure 10: Manually Assigning Analog I/O Module to its Resident Backplane 
Slot 

 

Select the slot in the PACSystems backplane that contains (or will contain) 
the HART-capable analog module to be configured. Slot 0 does not support 
analog modules, so is not an available option. 
Repeat this step for each HART-capable analog module which has (or will 
have) HART devices attached. 

3. Add a HART Device DTM to an analog channel of the PACSystems 
HART capable Analog Module DTM. With the analog module node 
selected in the project, the Device Menu, Add or Add Device option 
will display a list of compatible HART devices available in the 
catalog. After selecting a HART device, a dialog like that shown in 
Figure 11 will commence: 

 
Figure 11: Manually Assigning HART Devices to Connected Analog I/O Module 
Channels 
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Select the analog channel that is physically wired (or will be wired) to the 
HART device.  

Repeat this step for each HART device connected to the HART-capable 
analog module. 

4. Set the operational parameters of each HART Device by selecting it 
in the project and selecting Parameterize from the Device Menu. 
This will open a custom dialog for that HART Device. Once all 
parameters have been keyed in, apply them to the HART Device 
and close the dialog box. 

Note: The name of a HART Device assigned within the project is required to match 
the HART Tag of the selected HART device.  The HART Tag may be read by HART 
Command #13. HART Device DTMs will automatically enforce this match, so if 
you change the name of the HART device within the project view or within the 
HART device configuration dialog(s), the same change is applied to both views. 
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4.3 System Operation 

This section describes how to communicate with a HART device attached 
to a PACSystems PLC. 

4.3.1 Connecting to a Device 

The HART device must be connected before any communications can 
begin. This is typically done by selecting the HART device and in the Device, 
menu choosing an option such as Go Online or Connect. 

The connect status (Connected or Disconnected) will be displayed in the 
lower left corner of the PACSystems HART Communications Configuration 
screen. 

If a valid PACSystems FDT HART DTMs license is not installed on the PC 
prior to attempting to connect to a device, the connect attempt will fail 
and an error message will indicate that a valid license must be installed. 

4.3.2 Operation with Redundant IP Address  

Only PACSystems PLCs configured for Hot Standby Redundancy operation 
support the use of communications via Redundant IP Address. 

One or both redundant targets must be in RUN mode for the Redundant 
IP Address to be operational. 

The PACSystems HART Communications DTM will automatically retry 
communication to the new Active Unit if a role switch occurs during 
communications. No errors are reported if the retry succeeds. 

Note that a loss of communication between the PC executing the DTMs 
and the Active Unit does not cause a change in the CPU redundancy roles 
even if the DTMs have connectivity to the Backup Unit. 

4.3.3 Observe Device Information 

The information that can be observed is device specific and may include 
the current, primary, secondary, tertiary, and quaternary values as well as 
vendor specific values. The format of the data is also device specific and 
can include the current values as well as trend lines etc. Once a device is 
connected choose Observe from the device menu. Device specific options 
may be present to select different modes of observation. 
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4.3.4 Communication Scheduling 

Each Device DTM running in the FDT Frame Application communicates with 
its physical device through the communication path built from the DTM 
layers and the interfacing hardware. The PLC CPU and analog modules 
each operate as a multiplexer, concentrating data from multiple sources 
into a single communication stream between the PC and CPU. Each analog 
module concentrates the Input and Status data from the connected HART 
devices; each PLC CPU scans the connected analog modules and 
concentrates all the HART data from all the HART devices before 
communicating them over Ethernet to the PC. Command and Output data 
flowing in the reverse direction is distributed from the PLC CPU via the 
analog modules to the connected HART devices. Figure 12shows a single 
command flowing from the Device DTM to the HART Device. 

Figure 12: HART Command Flow from HART DTM to HART Device

 

Since HART communications are significantly slower than Ethernet 
communications at the physical level, multiple HART commands can be run 
in parallel. Each Device DTM request is queued to go over the Ethernet 
connection and multiple requests can be in progress on the CPU. The 
queue depth on the CPU is not user-configurable. Figure 13 shows that 
there are multiple communication points on the HART Communications 
DTM and CPU which allow multiple requests (depicted with different line 
types) over one Ethernet connection. 
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Figure 13: Simultaneous HART Communications Activities

 

This concept is extended for more complicated topologies involving 
PROFINET. Each device DTM generates a command which is propagated 
through the DTM topology until it reaches the Communication DTM where 
it is sent to the CPU as a request. In the case of PROFINET communications, 
that request contains the information necessary to have the PROFINET IO 
Controller ask the required PROFINET IO Device about the HART device 
connected to it. 

4.4 Diagnostics 

This section describes: 

• Configuration and Parameter states 
• Communication Status 
• Error Log 

4.4.1 Configuration and Parameter States  

While editing a Configuration or Parameter element in a DTM, the FDT 
specification requires that feedback be displayed for invalid settings or 
modified settings. 

If a setting is currently invalid, the display will indicate an error, using the 

 icon or other similar signage. The validation of a setting may occur 

as information is being entered or may occur only when focus is 
transferred away from that element. Once the value is corrected, this error 
will clear. 

If a setting is valid but modified, the display will indicate that the value still 

needs to be committed, either to the device or the project, with an  

icon or other similar signage. Once the value is applied, this signage will 
clear. 
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4.4.2 Communication Status 

The status bar of Configuration and Parameterization dialogs contains the 
current status of the communications to that device.  Note that the 
Online/Offline state within the FDT Frame Application is not always equal 
to the communications status. Communication to a device is only 
established when needed, so if a component is online with no downstream 
devices online, there may be no need to connect to that component. The 
Communications status reflects the current state as Connected and 
Disconnected with icons that may display whether the connection is in 
transition or error. 

4.4.3 Error Log 

The FDT Frame Application contains an Error Log or Monitor which lists 
error events as they occur. The log display consists of a time stamp, 
identifies the source of the problem, which is typically the project tag of 
the component reporting the error, and provides a text description of the 
problem. 

Please consult the Error Log to diagnose individual problems. 

4.5 Frequently Asked Questions 

1. Q: I’ve run the installer. What do I do next? 

1. A: The installer installs PACSystems Common Licensing and the 
PACSystems HART Device Type Managers and registers the DTMs 
within Windows®. The next step is to start PACSystems Common 
Licensing and add a license for the DTMs. After that is done, start an 
FDT Frame Application and update its catalog. It will find all 
registered DTMs during the update. You can then add the 
PACSystems HART Communications DTM to the project, configure its 
network settings to the PLC system, and scan for HART components. 

2. Q: When I attempt to scan a PLC using an IP address that does not 
exist, why does it take longer than the provided Timeout for an error 
message to appear in the Error Log? 

2. A: When an Ethernet connection attempt is not successful after the 
Timeout duration expires, a single retry is attempted using the same 
Timeout duration. Consequently, a user must wait twice the Timeout 
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duration before an error is logged (assuming the Timeout value is 
less than 21 seconds). Standard Windows network settings allow for 
a maximum of 21 seconds before a timeout occurs, so Timeout 
values of greater than 21 seconds will time out after 21 seconds and 
log an error after 42 seconds. 

3. Q: A scan finds the PROFINET devices but does not find any HART-
capable analog modules, but they are in the rack. What is wrong? 

3. A: In order to report the presence of HART-capable analog modules, 
the PROFINET device must have a valid IP address that is accessible 
from the IO Controller. Verify a configuration for the PROFINET 
device is stored to the IO Controller PLC and there is an established 
PROFINET connection between the two with no errors. 

4. Q: A scan finds the HART-capable analog modules within the rack, but 
no HART devices are reported. I have HART devices connected to the 
module and the 4-20mA signal is working. What am I doing wrong? 

4. A: The HART modems within a HART-capable analog module must be 
enabled. After configuring the module channel for 4-20mA operation, 
you must enable HART communications for each channel that has a 
HART device attached to it. 

5. Q: The scan is showing me a dialog with a lot of red icons and then 
waiting for me to do something. What is the problem? 

5. A: This is an indication that the scanning process did not find an exact 
match. There could be no match or a partial match. There are two 
probably places in which a scan could return results which have no 
matching DTM. 

i. The scan of a PROFINET network returns all the PROFINET 
devices on the network. If there are non-Emerson PROFINET 
devices that do not have a DTM, each will be displayed with their 
PROFINET name and network settings. If there is an installed FDT 
DTM for that device, you can assign that DTM to the device now. 
If there is not a DTM for a PROFINET device, just leave these scan 
results unchanged and continue the scan. Nothing will be added 
to the FDT project for these PROFINET devices. 

ii. The scan of a HART channel returns the HART identification 
information for the device present. If there is not a matching 
HART device DTM installed, then the device will be displayed with 
the HART identification information returned. Simple devices 
may not have a device specific DTM. Often you can use a generic 
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HART device DTM which supports Universal and Common-
Practice HART commands for these devices. Any HART devices 
you do not assign a DTM to are ignored and nothing is added to 
the FDT project for these channels. 

6. Q: The scan found the PROFINET device and HART-capable analog 
modules, but then reports multiple errors trying to scan the HART 
channels. 

6. A: The scan for PROFINET devices and modules does not require the 
IO Controller to have an active connection with the PROFINET device. 
In order to scan the HART channels, the IO Controller have an 
established PROFINET connect with PROFINET device and the active 
configuration for HART module must be configured with the HART 
modem(s) enabled for the channel(s) with HART device(s).
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Section 5: HART Multiplexer 

5.1 Installation 

The PACSystems HART Multiplexer is installed using a Windows® 
Installation package. It should be installed on a PC that hosts a compatible 
asset management tool. 

In order to operate the PACSystems HART Multiplexer, a valid license must 
be installed on the PC. Licenses can be ordered as part number HM10 – 
HART Communications Virtual Serial Multiplexer for PACSystems RX3i. 

5.1.1 Install Process 

Steps to install the PACSystems HART Multiplexer are: 

1. Verify the requirements as listed in the Specifications tables in 
Section 1.4 

2. Login to the PC running Emerson AMS with a user with administrator 
privileges 

3. Exit all running programs 

4. Start Setup.exe from the installation medium 

5. Follow the instructions in the dialogs presented 

6. Install a license for the PACSystems HART Multiplexer using the 
PACSystems Common License Manager, which is installed in Start -> 
All Programs -> PACSystems Common -> License Manager. The 
license procedure is detailed in the License Documentation file 
installed with the License Manager. Licenses can be ordered as part 
number HM10 – HART Communications Virtual Serial Multiplexer for 
PACSystems RX3i. 

7. To verify the PACSystems HART Multiplexer service is running, right 
click Computer and select Manage. In the Computer Management 
console, expand Services and Applications and click Services. In the 
service list, locate PACSystems HART Multiplexer and verify that it has 
a Status of Started and a Startup Type of Automatic. 
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To install the PACSystems HART Multiplexer support in Emerson AMS: 

1. Execute Add Device Type from the Start Menu options for AMS 
Device Manager 

2. Accept warnings as necessary. There may be warnings of adding 
additional devices that are not shipped directly with AMS. 

3. Select Browse… and select the directory containing the file 
ddinstal.ini. Press OK. AMS should add the device and show that it 
has successfully updated the database with Intelligent Platforms 
PacsMux …. 

4. To verify the installation, open AMS Device Manager and expand 
the Device List in the Device Explorer view. There should be an 
entry for Intelligent Platforms->HART->PacsMux. 

5.1.2 Uninstall Process 

Exit all asset management tools and then, from the Windows® Programs 
Control Panel, apply the Uninstall option to the PACSystems HART 
Multiplexer. 

5.2 Configuration 

This section explains the procedure required to configure the PACSystems 
Multiplexer for HART Pass Through when using Emerson AMS with a 
PACSystems PLC. 

5.2.1 Configuration Overview 

HART communication is configured using the PACSystems HART 
Multiplexer Configuration Tool and Emerson AMS. The configuration of the 
Multiplexer contains the information needed to associate a COM Port to 
the IP Address of an RX3i system and discover all HART devices connected 
to the RX3i system. After communications has been established and HART 
devices have been discovered, Emerson AMS can be used to further 
configure the HART devices. 
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Initial Configuration Steps 

Follow these steps when first connecting an RX3i system with HART devices 
to Emerson AMS. Each step is further detailed in the document sections 
which follow. 

1. Associate a COM Port with an RX3i system using the PACSystems 
HART Multiplexer Configuration Tool. 

2. Add a Multiplexer Network using Emerson AMS. 

3. Build Device Hierarchy using Emerson AMS. 

Modifying an Existing System 

Follow these steps whenever a HART device is added, removed, or 
replaced. 

1. Rediscover the HART devices using the PACSystems HART Multiplexer 
Configuration Tool.  

2. Rebuild Device Hierarchy using Emerson AMS. 

5.2.2 PACSystems HART Multiplexer Configuration 

To configure the HART Multiplexer, run the PACSystems HART Multiplexer 
Configuration Tool. 

The configuration tool performs the following functions: 

• Associates a COM port for use by Emerson AMS with an RX3i system 
at the specified IP Address. 

• Discovers the location of each HART device within the RX3i system. 
Devices must be discovered before they can be used by Emerson 
AMS. 

In order to run the PACSystems HART Multiplexer Configuration Tool, a 
valid PACSystems HART Multiplexer license must be installed on the PC. 

The PACSystems HART Multiplexer Configuration Tool main screen 
displays a list of COM ports and associated RX3i system IP Addresses and 
settings. One entry must be configured for each RX3i system with HART 
devices. 
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Figure 14: Associating PLC COM Port with Emerson AMS

 

From the screen shown in Figure 14, you can add, delete, and edit 
networks. To add a network, right click anywhere in the table and selection 
Add network. To edit or delete an existing network, select the network and, 
when it is highlighted, right click to make the desired selection. 

Adding or editing a network will bring up a dialog box (Figure 15). Use it to 
fill out the corresponding network connection information. 

Figure 15: Adding or Editing a Network for HART Multiplexer
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1. Select the COM Port that will be used to communicate with Emerson 
AMS. Select any available port and the tool will create a virtual COM 
port. Once you apply your changes, the COM Port will be identified as 
an ELTIMA Virtual Serial Port in Device Manager.  No physical port is 
necessary. Ports that are listed as (in use) may be associated with 
removable USB devices or reserved for use by another application. 
Take note of the COM port selected as this is used to configure the 
Multiplexer Network in Emerson AMS. 

2. Enter the IP Address of the connection to the RX3i system. This can 
be the IP Address of a CPU-embedded Ethernet interface, the IP 
Address of a rack-mounted Ethernet Interface Module 
(IC695ETM001), or a redundant IP Address in a redundancy system. 

3. Configure the timeout value for the connection. This is a gross non-
activity timeout for operations between the host PC and the PLC CPU. 
The default is 16 seconds, typically it can be reduced to 8 seconds for 
higher performance CPUs with a separate PROFINET controller. 

4. Communication with HART devices via the PLC requires Privilege 
Level 2 access. Enter the password if a Level 2 Privilege Level 
password has been configured. 

5. Select the rediscover network checkbox to discover all HART devices 
connected to the PLC. Rediscovery should be chosen when adding a 
new RX3i system or when HART devices have been added, removed, 
or replaced. 

When complete, press OK to return to the previous screen. Any values that 
were modified will be displayed in bold. 

To apply the changes, press OK on the main screen. If there are changes 
or the multiplexer is not running, Windows® will prompt as necessary for 
administrative permissions to continue. Whenever rediscovering devices 
has been activated, make sure that the RX3i system is connected and has 
a valid hardware configuration. The multiplexer service will momentarily 
stop while changes are being applied. A progress bar is displayed while the 
changes are being applied. The program exits when all activities have been 
completed. 

Discovered HART Device Loop Number Assignments 
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During HART device discovery, the PACSystems HART Multiplexer: 

1. Discovers HART-capable analog modules and attached HART devices 
within a given PLC system. 

2. Creates one virtual Multiplexer Device instance for every 16 HART-
capable analog modules discovered, up to a maximum of 256 HART 
devices per instance. The PACSystems HART Multiplexer supports a 
maximum of 64 virtual Multiplexer Device instances, thus supporting 
a maximum of 1024 HART-capable analog modules per PLC system. 

3. Assigns a unique loop number from 0-255 to each of the discovered 
HART devices on each virtual Multiplexer Device. 

The PACSystems HART Multiplexer assigns loop numbers to discovered 
HART devices according to the following algorithm: 

1. HART devices discovered in the main rack are assigned first, followed 
by remote racks in order of the assigned PROFINET Device Number. 

2. Within each rack, HART-capable analog modules are reserved loops 
in slot order, low to high. For each HART-capable analog module 
present, 16 loops are reserved for potential HART devices regardless 
of channel configuration, the presence of HART devices, or the 
number of actual channels the analog module supports.  

3. Within each HART-capable analog module, loop assignments are 
made in analog channel order, low to high. 

Since each discovered HART-capable analog module reserves 16 loops for 
potential HART devices, adding or removing a HART device to an already 
discovered HART-capable analog module and performing HART device 
rediscovery will not alter the loop assignments for existing HART devices.  

However, adding (or removing) a HART-capable analog module to (or from) 
the main or remote rack and performing HART device rediscovery could 
cause existing HART devices to be bumped, and consequently be assigned 
to different loop numbers. For example, adding a HART-capable analog 
module to slot 10 of the main rack will cause an already discovered HART 
device in slot 11 to have its loop number incremented by 16. When this 
occurs, the Multiplexer Network in AMS that corresponds to this PLC 
system must be rebuilt. Follow the steps outlined in the Rebuild of Device 
Hierarchy topic of Section 5.2.3. 

Based on the number of HART-capable analog modules discovered, the 
resulting number of virtual Multiplexer Devices created by the PACSystems 
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HART Multiplexer must be configured in AMS. This configuration step is 
described in bullet 5.d of Section 5.2.3. 

Cross-Referencing Loop Number to Physical Location 

Emerson AMS identifies a HART device by its Multiplexer Network, 
Multiplexer Address, Loop, and HART Tag. After the PACSystems HART 
Multiplexer has discovered the HART Devices connected to the RX3i 
System, activating the Generate Report button creates a file cross-
referencing the PACSystems location to its Multiplexer location. 

Once a HART Multiplexer configuration has been discovered and applied, 
restart the PACSystems HART Multiplexer Configuration Tool. Activate 
Generate Report and select a location and filename for storage of that 
report. The Generate Report button is disabled (grayed out) if there are 
unapplied changes. 

Figure 16 shows an example list of discovered HART devices. The AMS COM 
Port, Multiplexer Address and Loop identify the location of each HART 
device in Emerson AMS. The PLC IP Address, PNC Slot, PNC Sub slot, 
Remote Device Name, Analog Module Slot, and Analog Module Channel 
uniquely identify the location of each HART instrument in the RX3i System, 
as last discovered. 

Figure 16: HART Multiplexer Cross-Reference Report

 

5.2.3 Emerson AMS Configuration 

Follow the instructions included with AMS to install the Device Manager 
application including HART Multiplexer Interface. 

Add a Multiplexer Network 

A separate Multiplexer Network is required for each RX3i system with HART 
devices. 

Steps to add a Multiplexer Network are: 
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1. Open the Network Configuration program. 

2. Select Add. 

3. Choose Multiplexer Network and select Install… 

4. Follow the instruction to name the multiplexer network and select 
Next. 

5. Configure the Mux Network Parameters: 

a. Set the COM Port to the value of the virtual AMS COM Port that 
was created during the PACSystems HART Multiplexer 
configuration. 

b. Set the Baud Rate to 19200. 

c. Emerson recommends using the default values for Network 
timeout of 1000 ms, Communication retries of 0, and HART Busy 
retries of 5. 

d. Each RS485 multiplexer address can support up to 256 HART 
loops.  The report created using the Generate Report button in the 
PACSystems HART Configuration Tool has a Multiplexer Address 
column that identifies the address assigned to each device.  
Set the Multiplexer Address Range RS485 Address from 0 to the 
maximum multiplexer address in the report. 

Note: Some versions of AMS may default to a Multiplexer address range beginning 
with address 1. This must be changed to 0. 

e. Verify that the Multiplexer HART Master Mode setting is set to 
Primary master. 

f. Select Finish. 

Initial Build of Device Hierarchy 

To initially build the device hierarchy in AMS, after the Multiplexer has 
completed discovery of HART devices within the control system: 

1. Open AMS Device Manager program. 

2. Select View -> Device Connection View to open the Device Connection 
View window. 

3. Locate the Multiplexer Network in the tree view under AMS Device 
Manager. 

4. Right click on the Multiplexer Network and select Rebuild Hierarchy.  
A virtual multiplexer will be found for each network address. 
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5. Right click on the Multiplexer Network and select Scan -> All Devices. 
AMS will automatically request device information from each HART 
device in the system. This operation may take many minutes to 
complete. 

6. Click the + icon next to a discovered multiplexer device and wait while 
Emerson AMS traverses the HART devices managed by this 
multiplexer. After this operation completes, a numerically ordered 
list of HART devices will be presented. 

7. If desired, drag and drop each HART device into a Plant Database 
location. 

Rebuild of Device Hierarchy 

To add new HART devices into an existing device hierarchy, after the 
Multiplexer has completed a rediscovery of HART devices within the 
control system: 

1. Open AMS Device Manager program. 

2. Select View -> Device Connection View to open the Device 
Connection View window. 

3. Locate the Multiplexer Network in the tree view under AMS Device 
Manager. 

4. Right click on the Multiplexer Network and select Rebuild 
Hierarchy. 

5. Right click on the Multiplexer Network and select Scan -> New 
Devices. This operation may take many minutes to complete. 

6. If desired, drag and drop each new HART device into a Plant 
Database location. 

Viewing Device Discovery Date 

The PACSystems HART Multiplexer internally keeps the date that devices 
were last discovered for each multiplexer network. The steps to view this 
date from within AMS are as follows:  

1. Open AMS Device Manager program. 

2. Select View -> Device Connection View to open the Device 
Connection View window.  

7. Locate the Multiplexer Network in the tree view under AMS Device 
Manager. 
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3. Double click on the Multiplexer Network to expand the hierarchy. 

4. Right-click on one of the virtual multiplexers in the Multiplexer 
Network and select Configure/Setup. 

5. Click on the Device tab. 

 

Note: In PACSystems HART Multiplexer, the Descriptor, Message, and Date are read-
only. AMS may allow these fields to be edited; however, using the Send button 
on this Device tab should not be attempted, as an error message will be 
generated, since the write operation is not supported. 

For additional information on Emerson AMS features and configuration 
refer to the product specific documentation. 

5.3 System Operation 

5.3.1 Operation with Redundant IP Address  

Only PACSystems PLCs configured for Hot Standby Redundancy operation 
support the use of communications via Redundant IP Address. 

One or both redundant targets must be in RUN mode for the Redundant 
IP Address to be operational. 

The HART Multiplexer will automatically retry communication to the new 
Active Unit if a role switch occurs during communications. No errors are 
reported if the retry succeeds. 

Note that a loss of communication between the PC running the HART 
Multiplexer and the Active Unit does not cause a change in the CPU 
redundancy roles even if the HART Multiplexer has connectivity to the 
Backup Unit. 

5.3.2 HART Device Configuration, Diagnostics, and 
Process Variables 

After a HART device is identified in Emerson AMS, the device can be 
configured and have its diagnostic data and process variables inspected. 

• To configure the HART device, right click the identified HART device 
and select Configure/Setup. 

• To inspect the diagnostic data of a HART device, right click on the 
identified HART device and select Device Diagnostics. 
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• To inspect the process variables of a HART device, right click on the 
identified HART device and select Process Variables. 

For additional information on Emerson AMS features and configuration 
refer to the product specific documentation. 

5.4 Diagnostics 

PACSystems HART Multiplexer events are logged in the Windows® 
Application Event Log. To view the Application Event Log run 
compmgmt.msc and select Computer Management->System Tools->Event 
Viewer->Windows® Logs->Application.  The source will be displayed as 
PACSystems HART Multiplexer. 

There are three types of events: 

• Informational – Describes system events such as starting or stopping 
the service. 

• Warning – Events where the multiplexer can continue to operate. 

• Error – The multiplexer was unable to successfully complete an 
operation.  HART communication may be limited or unavailable until 
the error condition has been corrected. 

Select an event to see more information in the General and Details tabs. 

Figure 17: Display of Diagnostics Log

 

5.5 Frequently Asked Questions 

1. Q: I’ve run the installer. What do I do next? 
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1. A: The installer installs PACsystems Common Licensing, the 
PACSystems HART Multiplexer Configuration Tool and the 
PACSystems HART Multiplexer service. The next step is to start 
PACSystems Common Licensing and add a license for the 
multiplexer. After that is done, start the configuration tool and add 
a network for each PLC system enabling the Rediscover checkbox. 
After the service has started, restart the configuration tool and 
generate a report. Until there are HART devices shown in the 
report, the issues are with the PLC configuration and HART 
Multiplexer Configuration Tool settings. Check the Windows® 
Application Event Log for any errors or warnings. 

2. Q: There are no HART devices in the report generated by the HART 
Multiplexer Configuration Tool and no errors or warnings in the 
Windows® Application Event log. What’s wrong? 

2. A: There are a few things to check:  

• Is there a connection between the IO Controller and its IO 
Devices? 

• Was the Rediscover checkbox selected in the configuration tool? 

• Is HART enabled on the necessary analog module channels and 
is that configuration stored to the PLC? 

• Is the IP Address correct for the IO Controller? 

3. Q: I have HART devices in the report generated by the configuration 
tool, but nothing shows up in AMS Device Manager. What is wrong? 

3. A: The Multiplexer Network configuration in the AMS Network 
Configuration tool is probably not configured properly. In the AMS 
Network Configuration tool, add a Multiplexer Network and assign 
it to the AMS COM Port shown in the HART Multiplexer 
Configuration Tool. Pay attention to the Multiplexer Address range. 
It defaults to 1 to 1, but the configuration tool starts assigning 
HART devices at address 0, so you may have to move the minimum 
address down to 0 and increase the maximum address to the 
largest Multiplexer Address shown in the report generated by the 
HART Multiplexer Configuration Tool. 

4. Q: A device has failed, and I’ve replaced it with new hardware in the 
field. How do I use the new hardware in AMS Device Manager? 
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4. A: This will require restarting the PACSystems HART Multiplexer 
service, so it will disrupt AMS Device Manager. The following 
procedure lays out the steps required: 

i. Use the PACSystems HART Multiplexer Configuration Tool and 
edit the PLC System that includes the new hardware. Check the 
Rediscover checkbox and click OK twice to scan the modified 
system. 

ii. In the AMS Device Manager, select the PACSystems HART 
Multiplexer object that has the loop for the new device. (This 
information is available in the report generated by the 
PACSystems HART Multiplexer Configuration Tool.) Select 
Discover New Devices from the right-click menu of the 
Multiplexer in AMS Device Manager. The new hardware should 
be added to the database as a Spare HART device. 

iii. Select the old HART Device from within the Plant area in AMS 
and select Replace and follow the prompts to replace the old 
device with the new Spare device. This will allow you to apply 
the same configuration to the new hardware. 

 



 

 

General Contact Information  

Home link:     http://www.emerson.com/industrial-automation-controls 

Knowledge Base:     https://www.emerson.com/industrial-automation-controls/support  

Technical Support  

Americas 
Phone:  1-888-565-4155 
            1-434-214-8532 (If toll free option is unavailable) 
 

Customer Care (Quotes/Orders/Returns): customercare.mas@emerson.com 
Technical Support: support.mas@emerson.com 

  
Europe  
Phone:   +800-4444-8001 
           +420-225-379-328 (If toll free option is unavailable) 
 

Customer Care (Quotes/Orders/Returns): customercare.emea.mas@emerson.com 
Technical Support: support.mas.emea@emerson.com 

  
Asia 
Phone:     +86-400-842-8599 
               +65-6955-9413 (All other Countries) 
 

Customer Care (Quotes/Orders/Returns): customercare.cn.mas@emerson.com 
Technical Support: support.mas.apac@emerson.com 

  

Any escalation request should be sent to: mas.sfdcescalation@emerson.com 

 

Note: If the product is purchased through an Authorized Channel Partner, please contact the seller directly for 
any support. 

 

Emerson reserves the right to modify or improve the designs or specifications of the products mentioned in this manual at 
any time without notice. Emerson does not assume responsibility for the selection, use or maintenance of any product. 
Responsibility for proper selection, use and maintenance of any Emerson product remains solely with the purchaser.  
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